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ВВЕДЕНИЕ 

Microsoft Access XP — профессиональная программа управления базами 

данных. С ее помощью можно накапливать и систематизировать разнообразную 

информацию, искать и сортировать объекты согласно выбранным критериям, 

конструировать удобные формы для ввода данных и генерировать на основании 

имеющихся записей прекрасно оформленные отчеты. Access обеспечивает 

одновременный доступ к данным десяткам пользователей. 

Базы данных — это совокупность структур, предназначенных для 

хранения больших объемов информации и программных модулей, 

осуществляющих управление данными, их выборку, сортировку и другие 

подобные действия. Информация базы данных хранится в одной или нескольких 

таблицах. Любая таблица с данными состоит из набора однотипных записей, 

расположенных друг за другом. Они представляют собой строки таблицы, 

которые можно добавлять, удалять или изменять. Каждая запись является 

набором именованных полей, или ячеек, которые могут хранить самую 

разнообразную информацию, начиная от даты рождения и заканчивая подробным 

описанием кулинарного рецепта. Однотипные поля разных записей образуют 

столбец таблицы. 

Записи одной таблицы могут содержать ссылки на данные другой таблицы, 

например, в таблице со списком товаров могут храниться ссылки на справочник 

производителей товаров с их адресами и другими реквизитами. При этом записи, 

касающиеся разных товаров, могут указывать на одного и того же производителя. 

Такое взаимодействие таблиц называется связью. 

           Другие модули базы данных предназначены для обработки информации, 

хранящейся в таблицах. С помощью запросов производится выборка данных, 

отвечающих определенным условиям. Формы предназначены для 

форматированного ввода и восприятия информации. Отчеты обеспечивают 

вывод (как правило, на принтер) красочно оформленного списка записей с 

заголовками, пунктами и подпунктами. 
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ЛАБОРАТОРНАЯ РАБОТА 1 

ИНТЕРФЕЙС СРЕДЫ MS ACCESS 

Каждое запущенное приложение Windows имеет свое окно, в котором 

выводятся результаты его работы - окно приложения. В данном случае окном 

приложения является главное окно Access. Кроме окна приложения Access 

широко используются еще два типа окон: диалоговые окна и окна документов. 

Окна приложения и окна документов могут перемещаться по экрану монитора, 

имеют изменяемые размеры и могут быть свернуты, развернуты или развернуты 

до максимальных размеров. Диалоговые окна можно перемещать по экрану, но 

они имеют постоянные размеры и их нельзя свернуть или развернуть.  

Строка в верхней части окна приложения, содержащая название 

приложения, является заголовком окна приложения (рис. 1). Заголовок окна 

приложения используется для перемещения окна по экрану (только если окно 

приложения свернуто и не развернуто до максимальных размеров). Окно 

документа, так же как и окно приложения, имеет заголовок, содержащий название 

этого документа. 

Строка состояния в нижней части окна приложения или документа служит 

для отображения подсказок о командах и кнопки и сведений о выполняемых 

операциях. 

Большинство объектов базы данных Access : таблицы, запросы, формы, 

отчеты, страницы доступа к данным и макросы - выводятся в окнах, которые в 

терминологии Windows являются окнами документов. Исключение составляют 

программные модули - для их представления используется специальная среда 

программирования . 

Access 2002 поддерживает интерфейс множественных документов (Multiple 

Document Interface - MDI), который позволяет открыть в рабочем поле окна 

приложения несколько окон документов одновременно. 

Окна приложения и все окна документов Access 2002 по умолчанию 

отображаются на Панели задач вашей операционной системы. Вы можете 

активировать любое из этих окон, нажав мышью по соответствующему значку.  

Активным окном называется окно, в которое направляются все сообщения 

(действия) от мыши или клавиатуры. Заголовок окна активного приложения или 

документа подсвечивается цветом, выбранным при установке параметров 

оформления рабочего стола (обычно это синий цвет). Если окно приложения и 
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окно документа в нем являются активными одновременно, то все сообщения от 

клавиатуры и мыши получает окно документа.  

Одновременно могут быть активными только одно окно приложения и окно 

документа в этом применении. Все остальные окна считаются неактивными (их 

название выводится на сером фоне). Нажатие левой кнопкой мыши по неактивной 

окну делает его активным и переводит на передний план. Если нужное окно 

полностью закрыто другими окнами, то сделать его активным можно, выбрав 

название документа в меню Окно (Window). 

Чтобы закрыть окно документа или приложения, необходимо нажать 

кнопку Закрыть в заголовке окна справа (на ней изображен крестик). 

Нажатие кнопки Развернуть в заголовке окна приложения (на ней 

изображен квадратик) позволяет установить максимальные размеры окна 

приложения. Нажатие кнопки Развернуть в заголовке окна документа позволяет 

максимизировать его в окне приложения. В заголовке развернутого окна (как 

документа, так и приложения) вместо кнопки Развернуть появляется кнопка 

Восстановить (с изображением двух наложенных квадратиков), нажатие которой 

вызывает возвращение окну прежних размеров. Кнопка Свернуть (на ней 

изображен знак подчеркивания) позволяет минимизировать окно приложения или 

документа. Окно приложения при этом сворачивается в значок на Панели задач 

вашей операционной системы, а окно документа - в значок в нижней части окна 

приложения. Обратную ею функцию выполняет кнопка восстановить. Она 

позволяет вернуть окну те размеры, которые оно имело до применения операций 

свертывания. 

Максимально развернутое окно документа занимает все поле окна 

приложения. Кнопки Свернуть, Восстановить и Закрыть при этом перемещаются 

в правую часть строки главного меню приложения.  

В Access 2002 так же, как и в других приложениях Microsoft Office, 

используются два типа меню : раскрывающиеся и контекстные. Контекстное 

меню появляется на экране при нажатии правой кнопкой мыши по объекту, с 

которым вы хотите работать. Оно содержит перечень действий, которые можно 

выполнять с этим объектом в данном контексте.  

Примером раскрывающегося меню может служить системное меню окна 

приложения или документа. Системное меню окна приложения появляется при 

щелчке левой кнопкой мыши по значку приложения, который находится в левой 

части заголовка окна приложения. Системное меню документа открывается после 
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нажатия левой кнопкой мыши по значку документа, который находится в левой 

части заголовка окна документа. Системное меню предназначено для изменения 

параметров окна.  

Строка под заголовком окна приложения содержит главное меню 

приложения, с помощью которого можно получить доступ к командам меню. Вид 

главного меню Access 2002 зависит от режима, в котором находится приложение. 

Например, когда активным окном является окно таблицы, в главном меню 

появляется команда Запись (Record), которая отсутствует в других режимах 

работы. 

Ниже строки меню располагается панель инструментов, на которой 

находятся кнопки. Многие кнопки имеют тот же внешний вид и назначение, что и 

в других приложениях Microsoft Office, но, конечно, большинство предназначено 

для выполнения специфических функций Access. Кнопки панели инструментов 

часто дублируют команды меню. Access 2002 27 стандартных панелей 

инструментов, которые выводятся на экран в зависимости от того, какой объект 

активен в данный момент. 

Все кнопки панелей инструментов имеют "всплывающие" подсказки, 

объясняющие их назначение. Подсказки появляются, если подвести к кнопке 

курсор мыши и немного подождать. Если подсказки не появляются, значит, они 

отключены. Чтобы включить режим вывода подсказок, выполните команду меню 

Вид, Панели инструментов, Настройки (View, Toobars, Customize) и в диалоговом 

окне Настройка (Customize) и на вкладке Параметры (Options) установите флажок 

Отображать подсказки для кнопок (Show ScreenTips on toolbars). 

Панели инструментов могут фиксироваться вдоль границы окна 

приложения, а могут быть плавающими, то есть переміщуваними по экрану. В 

этом случае панель инструментов будет иметь заголовок и может менять свою 

форму и размеры. Левый край панели инструментов замечен вертикальной 

линией. Если подвести курсор мыши к этой линии, нажать левую кнопку мыши и, 

не отпуская, потянуть вправо, панель будет перемещаться вдоль границы окна. А 

если потянуть вниз, панель инструментов превратится в плавающую. Такую 

панель можно перемещать по экрану, зацепив за заголовок. 

Меню и панели инструментов по умолчанию отображены только наиболее 

часто используемые команды и кнопки. Чтобы получить полный список команд 

меню, необходимо нажать мышью по двойной стрелке у нижнего края 

раскрывающегося меню. Если не все кнопки поместились на панели 

инструментов, то у ее правого края тоже появляется значок двойной стрелки. 
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Если нажать мышью по нему, будут показаны оставшиеся кнопки. Если вы 

использовали какую-то кнопку или команду, которой не было по умолчанию в 

соответствующей панели или меню, то в дальнейшем она будет там показана.  

Меню и панели инструментов Access являются настраиваемыми, то есть 

можно менять состав кнопок, удаляя ненужные или добавляя новые кнопки. 

 

Рис. 1. Структура окна Microsoft Access 

1 – Заголовок окна; 2 – Главное меню; 

3 – Панель инструментов; 4 – Окно документа. 

 

Вопросы для самопроверки 

1. Что содержит в себе окно приложения Access? 

2. Какие меню по умолчанию отображаются в Access? 

3. Какие панели инструментов по умолчанию отображены в Access? 
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ЛАБОРАТОРНАЯ РАБОТА 2 

СОЗДАНИЕ БАЗЫ ДАННЫХ С ПОМОЩЬЮ МАСТЕРА И 

КОНСТУКТОРА ТАБЛИЦ 

МАСТЕР ТАБЛИЦ 

С помощью мастера таблиц можно создавать некоторые часто 

встречающиеся структуры данных. Прежде чем заново строить структуру 

таблицы, подумайте, нельзя ли воспользоваться одним из стандартных шаблонов 

мастера таблиц. Это позволит сэкономить время. Например, чтобы создать 

таблицу данных, предназначенную для хранения списка людей, с которыми вы 

контактируете, выполните следующие действия. 

1.  Запустите Microsoft Access, выполнив соответствующую команду меню 

Пуск > Программы (Start > Programs).  

  В появившемся в области задач приложения окне Создание файл? (New 

File) в разделе Создание (New) щелкните на пункте Новая база данных (Blank 

Access Database) (рис. 2.1). 

Откроется окно диалога Файл новой базы данных (File New Database). 

 

Рис. 2.1. Окно Microsoft Access 
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3. Выберите для размещения новой базы данных папку Мои документы 

(My Documents). В поле Имя файла (File Name) введите имя Контакты. Затем 

щелкните па кнопке Создать (Create). 

Откроется окно базы данных, показанное на рис. 2.2. Оно является 

основным окном базы и позволяет открывать, добавлять и удалять любые 

объекты базы данных. В левой области окна находятся кнопки групп объектов. В 

его правой части расположен список объектов выбранного типа, имеющихся в 

текущей базе данных, а также значки команд, позволяющих создавать новые 

объекты данного типа. Пока что в этой базе данных нет ни одного объекта.  

4. Щелкните на кнопке Таблицы (Tables). 

5. Чтобы запустить мастер создания таблиц, дважды щелкните на значке 

Создание таблицы с помощью мастера (Create Table By Using Wizard).  

 

Рис. 2.2. Окно базы данных 

В первом окне мастера, показанном на рис. 2.3, нужно указать 

подходящую структуру и выбрать в ней необходимый набор полей. 

6. Выберите положение переключателя Деловые (Business). 

7. В списке Образцы таблиц (Sample Tables) выберите пункт Контакты 

(Contacts).  
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 8. Щелкните на пункте Имя (FirstName) списка Образцы полей (Sample 

Fields).  

6.  9.  Щелкните на кнопке со стрелкой вправо, чтобы добавить выбранное 

поле в структуру создаваемой таблицы.  

10. Повторяя шаги 8 и 9, добавьте в список Поля новой таблицы (Fields In 

My New Table) поля Фамилия (LastName), Адрес (Address), НазваниеКомпании 

(Company Name) и РабочийТелефон (WorkPhone).  

11. Щелкните на кнопке Далее (Next). 

12. В поле второго окна мастера введите слово Контакты, которое будет 

играть роль имени таблицы. Затем щелкните на кнопке Далее. 

 

Рис. 2.3. Мастер создания таблиц 

13. В третьем окне мастера щелкните на кнопке Готово (Finish). Мастер 

сгенерирует таблицу и откроет ее в режиме ввода данных. 

Обратите внимание: поскольку во втором окне осталось выбранным 

положение переключателя Microsoft Access автоматически определяет ключ (Yes, 

Set A Primary Key For Me), Access добавляет в таблицу дополнительное ключевое 

поле Код_ Контакты (КонтактыЮ), которое играет роль уникального 

идентификатора записей. 
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Таблица данных похожа на лист электронной таблицы, но ее размеры 

ограничены. Число ее строк на единицу больше количества записей (последняя 

пустая строка предназначена для ввода новой записи), а число столбцов равно 

количеству полей в записи. Заголовки столбцов таблицы соответствуют именам 

полей, сформированных с помощью мастера создания таблиц. 

1. Щелкните на поле Имя и введите какое-нибудь имя. Access 

автоматически добавит в таблицу, созданную на предыдущем упражнении, 

первую запись, а строка новой записи сместится вниз. 

2. Введите фамилию в поле Фамилия. 

3. Заполните все остальные поля первой записи. 

1. 4.  Щелкните на поле Имя последней строки и введите имя еще одного 

человека, его фамилию, адрес, название компании и телефон. Добавьте 

подобным образом несколько записей, чтобы таблица стала такой, как 

показано на рис. 2.4. Если вы ошиблись при вводе, просто щелкните на 

ячейке с неверными данными и отредактируйте их. Стандартные заголовки 

столбцов часто оказываются неудобными, поэтому Access позволяет 

заменять их.  

 

Рис. 2.4. Таблица данных 

       5.  Щелкните на заголовке Фамилия правой кнопкой мыши и выберите 

команду Переименовать (Rename).  

6. Введите слово Название, которое заменит подсвеченный заголовок 

Фамилия. 

7. Повторив шаги 5 и 6, верните столбцу название Фамилия. 

8. Щелчком на кнопке Первая запись (First Record) переместите указатель 

теку щей записи в начало таблицы. 
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        9. Два раза щелкните на кнопке Следующая запись (Next Record), чтобы 

перейти к четвертой записи.  

            10. Щелкните на кнопке Удалить запись (Delete Record) панели 

инструментов.  

11. В появившемся окне запроса, информирующем о невозможности 

отмены операции удаления записи, щелчком на кнопке Да (Yes) подтвердите 

необходимость удаления. Обратите внимание, что ключевое поле Код_Контакты 

автоматически заполняется некоторыми числами. Эти числа не обязательно 

образуют непрерывную последовательность. Единственным условием является их 

уникальность. Содержимое ключевого поля различно для всех записей таблицы, 

что позволяет однозначно идентифицировать запись. Такие поля используются 

для формирования связей таблиц, о которых вы узнаете на этом занятии позже. 

КОНСТРУКТОР ТАБЛИЦ 

Конструктор таблиц предназначен для задания и изменения структуры 

таблицы. С помощью конструктора можно формировать сколь угодно сложные 

таблицы с полями любого типа. 

С помощью мастера таблиц была создана таблица для хранения данных о 

людях, с которыми вы контактируете. Теперь давайте с помощью конструктора 

добавим в базу данных еще одну таблицу, предназначенную для записи всех 

случаев контакта с людьми из первой таблицы. 

1. Щелчком на кнопке Окно базы данных (Database Window) 

переключитесь на список таблиц базы данных. 

1. 2. Дважды щелкните на значке Создание таблицы в режиме конструктора 

(Create Table In Design View). Окно конструктора, показанное на рис. 2.5, 

состоит из двух частей. В верхней отображается список полей таблицы, а в 

нижней — свойства выделенного поля.  

3. Введите слово Дата, которое будет играть роль названия нового поля. 

4. Щелкните на ячейке Тип данных (Data Type) первой строки списка 

полей. Здесь необходимо выбрать тип поля, который определяет структуру и 

размер данных. 

5. Щелкните на появившейся стрелке раскрывающегося списка ячейки Тип 

данных и выберите пункт Дата/время (Date/Time). 
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6. Нажмите клавишу Tab и введите расшифровку назначения поля: Дата 

контакта. Такие описания вводить не обязательно, но их наличие помогает 

разобраться в структуре таблицы. 

7.  Щелкните на второй ячейке столбца Имя поля (Field Name) и введите 

имя Описание. 

8. Задайте для второго поля тип Текстовый (Text). 

 

Рис. 2.5. Конструктор таблиц 

9. Укажите назначение поля в соответствии с рис. 2.5. 

Кроме даты и описания контакта таблица данных должна содержать 

информацию о том, с кем вы контактировали. Но список людей хранится в 

таблице Контакты, поэтому в новой таблице не нужно заново вводить имя и 

фамилию. Достаточно лишь добавить ссылку на одну из записей таблицы 

Контакты. Эта ссылка будет иметь числовой тип и содержать число, равное 

значению поля Код_Контакты соответствующей записи таблицы Контакты. 

10. Добавьте еще одно поле с именем Код_Контакты и типом Числовой 

(Number), 

Теперь нужно добавить индексированное поле и назначить его ключом, 

однозначно' идентифицирующим записи таблицы. Индексированные поля, или 

индексы, отличаются от обычных тем, что для них Access создает специальные 

списки, позволяющие выполнять быструю сортировку и поиск по содержимому 
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индексированного поля. Таблица может содержать несколько индексов. Ключ — 

это специальный индекс, идентифицирующий записи. Значения такого поля 

должны быть уникальными. Его наличие не обязательно, но оно так часто 

используется, что при отсутствии ключа Access напоминает об этом и предлагает 

автоматически добавить ключевое поле. 

11. Добавьте поле Ключ и назначьте ему тип Счетчик (AutoNumber). Такой 

тип данных избавляет пользователя от необходимости ввода значений ключевого 

поля и инициирует автоматическую генерацию уникальных значений. 

12. Сохраняя активной строку Ключ, щелкните на кнопке Ключевое поле 

(Primary Key). На кнопке этой строки появится значок ключа, показывающий 

особый статус поля. 

13. Щелкните на кнопке закрытия окна конструктора. 

14.  Access спросит о необходимости сохранения структуры таблицы. В 

ответ щелкните на кнопке Да. 

15.  В открывшемся окне диалога (рис. 2.6) введите имя Список. 

 

Рис. 2.6. Ввод имени таблицы 

16. Щелкните на кнопке ОК. 

СПИСОК ПОДСТАНОВКИ 

Пришло время наполнить таблицу Список конкретной информацией. Для 

этого выполните следующие шаги. 

1. В окне базы данных откройте список таблиц и дважды щелкните на 

значке Список. Выбранная таблица откроется в режиме просмотра данных. 

2. Добавьте несколько записей в соответствии с рис. 2.7. 
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Рис. 2.7 Список состоявшихся контактов 

3. Щелкните на кнопке Вид (View) панели инструментов. Откроется окно 

конструктора таблицы. 

4.  В списке типа данных для поля Код_Контакты выберите пункт Мастер 

подстановок (Lookup Wizard). 

5. В первом окне мастера оставьте выбранным положение переключателя 

Объект «столбец подстановки» будет использовать значения из таблицы или 

запроса (I Want The Lookup Column To Look Up The Values In The Table Or Query) 

и щелкните на кнопке Далее. Три положения переключателя второго окна мастера 

выводят на экран список таблиц, запросов или объединяют эти два списка. Здесь 

нужно выбрать таблицу или запрос на роль источника подстановки. В нашем 

случае база данных кроме таблицы Список содержит только один объект — 

таблицу Контакты, которая и окажется выбранной в окне мастера. 

6. Щелкните на кнопке Далее. Третье окно мастера, показанное на рис. 2.8, 

предлагает выбрать из таблицы Контакты поля, участвующие в подстановке. Этот 

список обязан содержать то поле, значения которого должны помещаться в поле 

Код_Контакты, то есть одноименное поле таблицы Контакты. 

7. Щелкните на пункте Код_Контакты. 

8. Щелкните на кнопке со стрелкой вправо. В список источника 

подстановки следует также добавить те поля, содержимое которых должно 

отображаться вместо численного значения, помещаемого из поля Код_Контакты 

таблицы Контакты в поле Код_Контакты таблицы Список. Я думаю, что будет 

удобно выбирать людей по их именам и фамилиям. 

9.  Добавьте в список Выбранные поля (Selected Fields) пункты Фамилия и 

Имя. 
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Рис. 2.8. Мастер подстановок 

 

Рис. 2.9. Параметры подстановки 

10.  Затем щелкните на кнопке Далее. 

11. В следующем окне мастер продемонстрирует два столбца таблицы-

источника, скрыв столбец Код_Контакты, содержащий идентификатор записи. 

Щелкните на кнопке Далее. 

12.  В поле последнего столбца введите название Контакт, которое заменит 

имя столбца Код_Контакты, и щелкните на кнопке Готово. 

13. В окне диалога щелчком на кнопке Да подтвердите необходимость 

сохранения построенной структуры. 

14. Щелкните на кнопке Вид, чтобы снова переключиться в режим ввода 

данных. 

Теперь в третьем столбце таблицы вместо чисел видны фамилии, 

соответствующие этим числам, хотя само значение поля Код_Контакты не 

изменилось. Access автоматически ищет соответствующую запись таблицы 
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Контакты по числу, содержащемуся в поле Код_Контакты, и выводит в ячейку 

текст поля Фамилия — второго поля таблицы Контакты из выбранных в окне 

мастера подстановки. Давайте попробуем добавить в таблицу Список еще одну 

запись. 

15. Щелкните на нижней ячейке столбца Дата и введите дату 10.10.10. 

 

Рис. 2.10. Список подстановки 

16. Нажмите клавишу Tab и напечатайте текст Письмо с предложениями о 

сотрудничестве. 

17. Снова нажмите клавишу Tab и щелкните на появившейся кнопке 

раскрывающегося списка, как показано на рис. 16.10. Теперь вы можете выбирать 

людей из списка подстановки, сформированного на базе полей Фамилия и Имя 

таблицы Контакты. 

18. Щелкните на втором пункте списка. 

Access автоматически отыщет в таблице Контакты значение поля 

Код_Контакты для записи, содержащей информацию о Петре Петрове, и введет 

найденное число в поле Код_Контакты таблицы Список. Это значение останется 

скрытым. Вместо него в ячейке таблицы Список появится соответствующая 

фамилия, взятая из таблицы Контакты. 

Вопросы для самопроверки 

1. Создание базы данных с помощью мастера таблиц. 

2. Создание базы данных с помощью конструктора таблиц. 

3. Список подстановок и его параметры. 
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ЛАБОРАТОРНАЯ РАБОТА 3 

СВЯЗЬ ТАБЛИЦ 

В предыдущей лабораторной работе с помощью мастера подстановок была 

сформирована связь между двумя таблицами. Такая связь позволяет установить 

правила взаимодействия между таблицами. Список подстановок можно было 

организовать и без связи. Но представьте, что вы удалите из таблицы Контакты 

запись, на которую ссылаются некоторые записи таблицы Список. В такой 

ситуации останутся описания контактов, фамилии людей в которых потеряны. 

Наличие правильно организованной связи позволяет избежать подобных 

неприятностей.  

1. 1. Выберите команду Сервис > Схема данных (Tools > Relationships). 

Откроется окно, схематически изображающее связи базы данных. На рис. 

3.1 видно, что линия связи соединяет поля Код_Контакты таблицы 

Контакты и Контакт таблицы Список.  

 

 

Рис. 3.1. Схема данных 

Для тренировки давайте удалим связь, а затем создадим ее заново. 

2. Щелчком выделите линию связи. 

3. Нажмите клавишу Delete. В ответ на появившийся запрос щелкните на 

кнопке Да. Связь исчезнет. 

4. Поместите указатель мыши на пункт Код_Контакты таблицы Контакты. 

5. Нажмите кнопку мыши и перетащите указатель на поле Контакт 

таблицы Список. 

6. В открывшемся окне диалога щелкните на кнопке Создать. Связь 

появится вновь. 
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Чтобы настроить параметры связи, выполните следующие шаги. 

7. 7.  Дважды щелкните на линии связи. Откроется окно диалога, показанное 

на рис. 3.2.  

 

 

Рис. 3.2. Параметры связи 

8. Установите флажок Обеспечение целостности данных (Enforce 

Referential Integrity). Этот режим не позволит Access оставлять в таблице Список 

записи, для которых нельзя подобрать запись таблицы Контакты с подходящим 

значением поля Код_Контакты. 

9.  Установите флажок Каскадное удаление связанных записей (Cascade 

Delete Related Records). Теперь при удалении записи таблицы Контакты (то есть 

удалении информации о конкретном человеке) будут удалены все 

соответствующие записи таблицы Список (то есть все описания контактов с этим 

человеком). Если указанный флажок сброшен, удаление тех записей таблицы 

Контакты, на которые ссылается хотя бы одна запись таблицы Список, 

запрещено. 

10. Щелкните на кнопке ОК.  

11. Закройте окно Схема данных. 

12.  В окне базы данных дважды щелкните на значке таблицы Контакты. В 

открывшемся окне таблицы видны небольшие знаки «плюс», расположенные в 
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левой части записей. Их присутствие говорит о наличии связи ключевого поля 

таблицы с другой таблицей. 

13. Щелкните на знаке «плюс» записи для Петра Петрова. Откроется 

вложенная таблица, содержащая те записи таблицы Список, значение поля 

Код_Контакты которых равно величине одноименного поля записи для Петра 

Петрова (рис. 3.3). 

 

Рис. 3.3. Выборка данных из связанной таблицы 

14. Щелкните еще на каком-нибудь знаке «плюс», и вы увидите описание 

всех контактов с еще одним человеком. Таким образом, с помощью созданной 

связи вы можете быстро просматривать в окне таблицы Список описания всех 

контактов с определенным человеком или группой лиц. 

Вопросы для самопроверки 

1. Связь таблиц. 

2. Параметры связи таблиц. 

3. Выборка данных из таблицы. 
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ЛАБОРАТОРНАЯ РАБОТА 4 

ПАРАМЕТРЫ ПОЛЯ. ИНДЕКСЫ 

Параметры поля 

Для того, чтобы обеспечить возможность хранения в базе данных 

разнообразной информации, Access предлагает большой набор типов данных, 

перечисленных в табл.4.1. 

Таблиця 4.1. Типи даних 

Назва типа 
Назначение 

 

Текстовый (Text) Текст длинй до 255 символов 

Поле MEMO (Memo) Текст длиной до 65 000 символов 

Числовой (Number) Числа различных форматов 

Дата / время (Date / 

Time) 
Дата и / или время 

Денежный(Currency) Денежные значения различных форматов 

Счетчик (AutoNumber) 

Счетчик, который автоматически увеличивается на 

единицу с добавлением каждой новой записи  

 

Логический (Yes / No) 

Величины, способные принимать только два значения: 

да/нет или 1/0  

 

Поле объекта OLE (OLE 

Object) 

Поля, позволяющие вставлять рисунки, звуки и данные 

других типов  

 

Гиперссылка  

(Hyperlink) 

Ссылки, дающие возможность открывать объект Access 

(таблицу, форму, запрос и т. п.), файл другого 

приложения или web-страницу  
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Чтобы сделать работу со списком контактов более продуктивной, следует 

изменить типы данных некоторых полей. 

 

Рис. 4.1. Выбор формата 

1. В окне базы данных выделите таблицу Список и щелкните на кнопке 

Конструктор (Design), расположенной в верхней части окна. Выбранная 

таблица откроется в режиме конструктора.  

2. Описание контакта может быть достаточно длинным, а максимальная 

длина текстовых полей ограничена 256 символами. Поэтому измените тип поля 

Описание на Поле MEMO. 

3. Щелкните на поле Дата.  

4. Для удобства прочтения даты контакта измените 4юрмат ее отображения, 

выбрав в раскрывающемся списке Формат поля (Format) пункт Длинный формат 

даты (Long Date), как показано на рис. 4.1. 

Кроме типа данных и формата отображения вкладка Общие (General) окна 

конструктора позволяет настроить некоторые дополнительные параметры поля, 

влияющие на способ ввода данных. Параметр Значение по умолчанию (Default 

Value) задает содержимое поля, которое записывается в новую запись в том 
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случае, если пользователь не ввел в это поле никаких данных. Если вы регулярно 

обновляете список контактов, то дата контакта чаще всего будет совпадать с 

текущей датой. Чтобы упростить ввод информации, можно задать текущую дату в 

качестве значения по умолчанию для поля Дата. 

5. Введите в поле Значение по умолчанию (Default Value) функцию Date(), 

которая возвращает текущую дату. В некоторых случаях требуется не только 

задать тип данных поля, но и ограничить его возможные значения некоторым 

интервалом или более сложным правилом отбора. Такое правило вводится в поле 

Условие на значение (Validation Rule). Предположим, вы точно знаете, что все 

контакты, которые будут заноситься в список, состоятся после 1 января 1999 г. 

Чтобы избежать ошибок, можно заставить Access сообщать вам о вводе неверной 

даты. Для этого выполните следующие шаги. 

          6. В поле Условие на значение щелкните на кнопке построителя выражений. 

Откроется окно диалога. Для задания условий или значений определенных 

параметров Access предлагает большой набор математических операций и 

функций. Построитель выражений помогает ориентироваться во всем 

многообразии функций Access. Верхнее прокручивающееся поле построителя 

содержит конструируемое выражение. Его можно изменять как путем 

непосредственного редактирования текста, так и с помощью других кнопок и 

списков построителя.  

7. Необходимо, чтобы дата записи была позднее, то есть больше, даты 1 

января 1999 г. Поэтому щелкните на кнопке >, чтобы добавить нужное условие. 

Теперь нужно указать дату, с которой выполняется сравнение. Дяя этого 

следует воспользоваться специальной функцией, преобразующей строковую 

константу в дату в формате Access. 

8. Дважды щелкните на папке Функции (Functions) в левом списке 

построителя выражений. 
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9.  Щелкните на папке Встроенные функции (Built-in Function), чтобы 

вывести список стандартных функций Access. 

10. В среднем списке выберите категорию Дата/время. 

11. Двойным щелчком на имени функции DateValue добавьте ее в поле 

выражения. Вместо местозаполнителя аргумента «stringexpr» нужно ввести 

конкретную дату в строковом формате. 

12. В поле выражения щелчком выделите текст «stringexpr», а затем 

напечатайте "1.1.99". 

13. Щелкните на кнопке ОК 

 

Рис. 4.2. Параметры поля Дата 

14. В поле Сообщение об ошибке (Validation Text) введите текст Неверная 

дата, который будет появляться при вводе даты, более ранней, чем 1 января 1999 

г. Окончательный набор параметров поля Дата показан на  рис. 4.2. 

15. Щелкните на кнопке закрытия окна конструктора. В окне запроса на 

обновление структуры таблицы щелкните на кнопке Да. По причине добавления 

условий на значения поля Дата Access запросит о необходимости проверки 
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содержимого этого поля в уже имеющихся записях таблицы. Щелкните на кнопке 

Нет (No), чтобы не выполнять проверку. 

16. Выделите таблицу Список в окне базы данных и щелкните на кнопке 

Открыть (Open). Теперь все даты отображаются в длинном формате, а в ячейке 

Дата в строке новой записи автоматически появляется текущая дата. 

17. Щелкните в ячейке Дата второй строки, измените ее содержимое на 

19.11.95 и нажмите клавишу Tab, чтобы перейти к следующему полю. Так как 

модифицированная дата предшествует 1 января 1999 г., что противоречит 

настроенному условию, Access не позволит убрать курсор из текущей ячейки и 

откроет окно сообщения  с текстом, введенным вами в поле Сообщение об 

ошибке конструктора таблицы на шаге 14. Такое сообщение будет появляться до 

тех пор, пока вы не скорректируете дату. 

18. Щелкните на кнопке ОК. 

19. Исправьте дату на 19.11.00. 

20. Закройте таблицу Список. 

Индекс 

Для ускорения поиска данных о конкретном человеке в таблице Контакты 

удобно рассортировать записи по алфавиту. Чтобы назначить сортировку по полю 

Фамилия, выполните следующие шаги. 

1. В окне базы данных щелкните на значке таблицы Контакты 

2. Щелчком на кнопке Открыть откройте таблицу в режиме 

редактирования. 

3. В окне таблицы щелкните на заголовке Фамилия, чтобы выделить 

столбец. 

4. Щелчком на кнопке Сортировка по возрастанию (Sort Ascending) 

упорядочите записи столбца фамилии таблицы по алфавиту (рис. 4.3). 

5. Вставьте в таблицу еще несколько человек с фамилией Петров. 

Например, Василий Петров, Николай Петров и Игорь Петров. Добавляйте записи 

в указанном порядке. 
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Рис. 4.3. Сортировка фамилий по алфавиту 

6.  Чтобы обновить сортировку, закройте окно таблицы Контакты и вновь 

откройте таблицу. Записи окажутся расположенными так, как показано на рис. 

4.4.  

 

Рис. 4.4. Несколько человек с одинаковыми фамилиями 

Фамилии упорядочены по алфавиту, но имена людей расставлены в 

беспорядке. Если бы в таблице было несколько сотен людей с фамилией Петров, 

то поиск нужного человека существенно бы осложнился. Чтобы выполнить 

сортировку сразу по нескольким полям, следует воспользоваться сложным 

индексом. Его настройка выполняется посредством следующих действий. 

7. Щелчком на кнопке Вид переключитесь в режим конструктора. 

8. Чтобы открыть окно индексов таблицы Контакты, показанное на рис. 

4.5, щелкните на кнопке Индексы (Indexes) панели инструментов. В окне 

индексов есть список со столбцами названия индекса, имени поля, по которому 

выполняется индексация, и режима сортировки (по возрастанию или по 
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убыванию). Мастер таблиц при создании таблицы Контакты индексировал ее 

потрем полям: Название Компании, Фамилия, Код_Контакты, добавив индексы с 

именами соответственно: Название Компании, Фамилия и PrimaryKey. Последний 

из трех индексов является ключом таблицы, однозначно идентифицирующим ее 

записи. Все имеющиеся индексы простые, то есть назначают сортировку только 

по одному полю. Чтобы записи с одинаковыми фамилиями располагались по 

алфавиту имен, следует модифицировать индекс Фамилия, добавив в него 

условие сортировки по полю Имя. Для этого выполните следующие шаги. 

 

Рис. 4.5. Индексы 

9. Щелкните правой кнопкой мыши на той строке, которая расположена 

ниже строки индекса Фамилия. 

10. Выберите в контекстном меню команду Добавить строки (Insert Rows), 

чтобы вставить одну пустую строку. 

11. В новой строке щелкните на кнопке раскрывающегося списка ячейки 

Имя поля. 

12. Выберите пункт Имя. В столбце Порядок сортировки (Sort Order) 

автоматически появится вариант по возрастанию (Ascending). 

В окне настройки индексов имена полей, по которым происходит 

упорядочивание в данном индексе, располагаются в строке с именем индекса и 

ниже ее в строках с пустой ячейкой Индекс (Index Name) в порядке убывания 

влияния поля. То есть первой выполняется сортировка по тому полю, которое в 
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данном индексе расположено выше. В одном индексе можно использовать до 10 

полей. Таким образом, теперь индекс Фамилия упорядочивает записи по алфавиту 

сначала по фамилиям, а потом по именам. 

 

Рис. 4.6. Сортировка по двум полям 

13. Закройте окно индексов. 

14. Щелкните на кнопке Вид, чтобы переключиться в режим 

редактирования таблицы. 

15. Ответьте Да на запрос о необходимости сохранения таблицы. Теперь 

имена оказались выстроенными по алфавиту, как показано на рис. 16.19. 

Поскольку перед этим уже была настроена сортировка по полю Фамилия (то есть 

по индексу Фамилия, главным полем которого является Фамилия), вам даже не 

пришлось перенастраивать сортировку. Модификация индекса автоматически 

привела к упорядочению имен. 

Вопросы для самопроверки 

1. Параметры поля. 

2. Индексы. 

3. Сортировка данных. 

4. Сортировка данных по двум полям. 
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ЛАБОРАТОРНАЯ РАБОТА 5 

СОЗДАНИЕ ЗАПРОСОВ С ПОМОЩЬЮ МАСТЕРА И 

КОНСТРУКТОРА ЗАПРОСОВ. УСЛОВИЕ ОТБОРА 

Запросы являются инструментом поиска и структурирования данных. 

Запрос, адресованный одной или нескольким таблицам, инициирует выборку 

определенной части данных и их передачу в таблицу, формируемую самим 

запросом. В результате вы получаете подмножество информационного множества 

исходных таблиц, сформированное по определенному закону. Если 

обрабатываемый объем информации велик, выделение необходимых данных в 

такое подмножество позволяет существенно сократить время их обработки. В 

системах типа клиент-сервер, где основные базы данных хранятся на файловом 

сервере, система запросов позволяет уменьшить объем информации, 

передаваемой через локальную сеть. 

Мастер запросов 

Чтобы упростить задачу пользователя, в состав Access включен мастер 

запросов, позволяющий автоматизировать процесс построения запроса. Давайте с 

помощью этого мастера выполним выборку информации из таблиц базы данных 

Контакты. 

1. В окне базы данных щелкните на кнопке Запросы (Queries). 

2. Дважды щелкните на значке Создание запроса с помощью мастера 

(Create Query By Using Wizard). 

3. В раскрывающемся списке Таблицы и запросы (Tables/Queries) первого 

окна мастера выберите таблицу Список (рис. 5.1). 

4.  В списке Доступные поля (Available Fields) щелкните на строке Дата. 

5. Щелкните на кнопке >, чтобы переместить выделенное поле в список 

Выбранные поля. 

6. Повторяя шаги 3-5, добавьте в список Выбранные поля поле, Описание 

таблицы Список, а также ноле Фамилия таблицы Контакты. 

7. Щелкните на кнопке Далее. 

8. Введите имя запроса Перечень контактов и щелкните на кнопке Готово. 

Access построит запрос и выполнит его. Запрос — это набор условий, 

согласно которым производится выборка информации из таблиц. Запуск запроса 
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формирует новую таблицу данных, единственным отличием которой от обычных 

таблиц является то, что с помощью повторных запусков запроса ее данные можно 

обновлять в соответствии с изменением информации источников данных запроса. 

 

Рис. 5.1. Мастер запросов 

В рассматриваемом случае условие отбора инициирует получение из 

таблицы Список полей Дата и Описание всех имеющихся записей, а также поля 

Фамилия таблицы Контакты. Таблицы Список и Контакты связаны между собой 

через поле Код_Контакты, при этом Контакты является главной таблицей, а 

Список — подчиненной (то есть каждой записи таблицы Список соответствует 

только одна запись таблицы Контакты). Поэтому в поле Фамилия результата 

запроса выводится фамилия из той записи таблицы Контакты, значение поля 

Код_Контакты которой совпадает со значением одноименного поля таблицы 

Список. 

Результат выполнения запроса показан на рис. 5.2. 

 

Рис. 5.2. Результат выполнения запроса  
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Конструктор запросов 

Мастер запросов умеет конструировать только простые условия отбора. 

Чтобы наложить дополнительные ограничения, следует пользоваться 

конструктором запросов, обеспечивающим полное управление параметрами 

запроса и построение сложных условий отбора данных. 

1. Чтобы переключиться в режим конструктора, выберите команду Вид > 

Конструктор (View > Design View). Окно конструктора показано на рис. 5.3. В его 

верхней части отображаются списки полей таблиц, к которым обращается запрос, 

и связи между таблицами. Нижняя область содержит бланк выбора полей таблиц, 

условий отбора и режимов сортировки. Чтобы добавить в запрос еще одно поле, 

выполните следующие шаги.  

2. Переместите указатель на пункт Имя таблицы Контакты 

 

Рис. 5.3. Конструктор запроса 

3. Нажмите кнопку мыши и перетащите поле Имя в верхнюю ячейку 

четвертой строки бланка запроса. Его имя появится в этой ячейке, а имя 

соответствующей таблицы — во второй ячейке того же столбца. Третья строка 

бланка запроса позволяет сортировать результат запроса по тому или иному полю 
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4. В раскрывающемся списке третьей ячейки третьего столбца бланка 

выберите пункт По возрастанию. 

5. Назначьте тот же режим сортировки для поля Имя. Теперь записи 

результата запроса будут упорядочены по алфавиту фамилий и имен. Имеющийся 

вариант связи добавляет в результат запроса только те записи связанных таблиц, в 

которых значения полей Код_Контакты равны. Так как для некоторых людей из 

таблицы Контакты нет записей в таблице Список, то информация о таких людях 

не включается в результат запроса. Чтобы запрос возвращал данные даже о тех 

людях (включенных в таблицу Контакты), с которыми не было никаких 

контактов, нашедших отражение в таблице Список, следует изменить параметры 

объединения. 

6. Дважды щелкните на линии связи. 

7. 7. В открывшемся окне диалога Параметры объединения (Join Properties) 

выберите положение переключателя Объединение всех записей из 

"Контакты" и только тех записей из "Список", в которых связанные поля 

совпадают (Include All Records From "Контакты" And Only Those Records From 

"Список" Where The Joined Fields Are Equal).  

8. Щелкните на кнопке ОК. На одном конце линии связи появится стрелка, 

указывающая на смену режима объединения.  

9. Щелчком на кнопке Вид панели инструментов запустите запрос 

повторно. Результат выполнения запроса с учетом сортировки и нового режима 

объединения будет таким, как показано на рис. 5.5. 

10. Закройте окно запроса. 

11.  В ответ на вопрос о необходимости сохранения новой структуры 

запроса ответьте Да. 

Условие отбора 

Добавление в запрос условия отбора позволяет выбирать из таблицы не 

все записи, а лишь те, которые удовлетворяют определенным критериям. 

Например, вас могут заинтересовать контакты, приходящиеся на декабрь 1999 

года. Давайте модифицируем запрос добавлением соответствующего условия 

отбора. 

1.  Выделите в окне базы данных (рис. 5.4) значок запроса Перечень 

контактов. 
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2.  Щелкните на кнопке Конструктор. 

3.  В бланке запроса щелкните на ячейке Условие отбора (Criteria) 

первого столбца правой кнопкой мыши и выберите в контекстном меню команду 

Построить (Build). Откроется окно построителя выражений. 

 

Рис. 5.4. Окно базы данных 

4. В левом списке построителя щелкните на папке Операторы (Operators). 

5. В среднем списке выберите категорию Сравнения (Comparison). 

6. В правом списке дважды щелкните на пункте Between, чтобы добавить 

этот оператор в ноле формулы.  

7. Щелчком выделите в поле формулы первый местозаполнитель 

«Выражение» («Ехрr»). 

8. В левом списке построителя выражений двойным щелчком откройте 

папку Функции. 

9. Щелкните на папке Встроенные функции, содержащей стандартные 

функции Access. 

10. В среднем списке построителя выражений щелкните на пункте 

Дата/время (Data/Time). 
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11. В правом списке дважды щелкните на функции DateValue, чтобы 

заменить ею местозаполнитель «Выражение». 

12.  Нажмите два раза клавишу —>, выделив местозаполнитель 

«stringexpr».  

13. Введите текст "1.12.99". 

14. Повторяя шаги 7-13, замените второй местозаполнитель «Выражение» 

на выражение DateValue ("31.12.99"). 

У вас должна получиться формула Between DateValue ("1.12.99") And 

DateValue ("31.12.99"). Она проверяет условие нахождения даты в интервале от 1 

до 31 декабря 1999 г., то есть отбирает те записи, значение поля Дата которых 

относится к декабрю 1999 г. 

15. Щелкните па кнопке ОК. Построенная формула появится в ячейке 

Условие отбора первого столбца бланка запроса. При выборе записей, 

относящихся к одному месяцу, точная дата контакта может оказаться 

несущественной. Совсем выбросить это поле из бланка запроса нельзя, так как 

оно необходимо для реализации условия отбора. Однако любое поле можно 

скрыть, то есть не включать в результат запроса. 

16. Сбросьте флажок Вывод на экран (Show) первого столбца запроса  

(рис. 5.5).  

 

Рис. 5.5. Скрытие поля 

17. Щелчком на кнопке Запуск (Run) панели инструментов выполните 

запрос. 

 

Вопросы для самопроверки 

1. Создание запросов с помощью мастера запросов. 

2. Создание запросов с помощью мастера запросов.. 

3.  Добавление в запрос условия отбора. 
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ЛАБОРАТОРНАЯ РАБОТА 6 

ИТОГОВЫЙ ЗАПРОС. ЗАПРОС ДЕЙСТВИЯ 

Итоговый запрос 

Запросы позволяют не только выбирать записи из таблиц, но и вычислять 

различные статистические параметры. Например, можно подсчитать суммарное 

количество контактов и вывести даты первого и последнего контакта с каждым из 

людей, включенных в таблицу Контакты. Чтобы построить такой запрос в режиме 

конструктора, выполните следующие действия. 

          1. В окне базы данных щелкните на кнопке Запросы. 

2.  Дважды щелкните на значке Создание запроса в режиме конструктора 

(Create Query In Design View).  

          3.  В открывшемся окне диалога (рис. 6.1.) выделите строку Контакты. 

          4. Щелчком на кнопке Добавить добавьте выбранную таблицу в верхнюю 

область конструктора запроса. 

5. Выделите пункт Список и снова щелкните на кнопке Добавить.  

6. Щелчком на кнопке Закрыть закройте окно диалога Добавление таблицы 

(Show Table). Списки полей двух таблиц, соединенные линией связи, появятся в 

окне конструктора. 

7. Щелкните на кнопке Групповые операции (Totals) панели инструментов. 

В бланке запроса появится дополнительная строка Групповая операция: (Total), 

позволяющая выполнять статистические операции со значениями конкретных 

полей. 

8. Перетащите поле Фамилия в ячейку Поле (Field) первого столбца 

конструктора. 

9. В ту же ячейку второго столбца перетащите поле Имя таблицы 

Контакты. 

10. В третий, четвертый и пятый столбцы бланка запроса перетащите поле 

Дата таблицы Список (рис. 6.2).  

11. В раскрывающемся списке ячейки Групповая операция (Total) третьего 

столб ца бланка запроса выберите пункт Min. 
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Рис. 6.1. Добавление таблицы 

 

Рис. 6.2. Запрос с групповыми операциями 

12 В той же ячейке четвертого столбца выберите пункт Мах. 

13. В пятом столбце задайте групповую операцию Count. Групповые 

операции построенного запроса обработают все записи таблицы Список, 

соответствующие конкретному человеку из таблицы Контакты, и вместо самих 

данных таблицы Список выведут в соответствующее поле результата запроса 

только значение величины, вычисляемой по определенной формуле. Доступные 

групповые операции перечислены в табл. 6.1. 
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Таблиця 6.1. Групповые операции 

Название Функция 

Условие(Where) 

Режим задания условия отбора для поля, но которому не 

выполняется  группировка. Access автоматически делает такое 

поле скрытым 

Выражение 

(Expression) 

Вычисляемое поле, значение которого рассчитывается  по 

сложной формуле 

Group By 

Поле, определяющее группу записей, по которой вычисляются 

статистические параметры. К одной группе относятся все 

записи, для которых значения поля с режимом Group By 

(Группировка) одинаковы 

Last Последнее значение в группе 

First Первое значение в группе 

Var Вариация значений поля 

StDev Стандартное отклонение величин ноля от среднего 

Count 
Количество записей, соответствующее ноле которых не 

содержит величины Null 

Мах Максимальное значение 

Min Минимальное значение 

Avg Среднее значение поля 

Sum Сумма значений поля по всем записям 

 

14. Щелкните на кнопке Вид, чтобы выполнить запрос. Появится таблица с 

пятью столбцами. Два первых столбца содержат фамилии и имена людей. По ним 

выполняется группировка, то есть расчет значений остальных полей запроса 

выполняется для записей таблицы Список, сопоставляемых с одним человеком. 

Как уже говорилось выше, соответствие контакта таблицы Список и человека из 

таблицы Контакты определяется полями Код_Контакты, с помощью которых 

осуществляется связь этих двух таблиц. Третий и четвертый столбцы запроса 

выводят соответственно дату первого (функция Min) и последнего (функция Мах) 

контакта с данным человеком. Пятый столбец содержит количество записей в 

таблице Список (функция Count), соответствующих. данному человеку, то есть 

число контактов с ним. Единственный недостаток построенного запроса — это 

непонятные имена столбцов. Давайте скорректируем их. 

15. Щелчком на кнопке Вид вернитесь в конструктор запроса. 

16. В ячейке Поле третьего столбца замените имя Дата на текст Дата 

первого контакта: Дата. Правая часть этого выражения, расположенная правее 

двоеточия, по-прежнему задает имя поля, а левая определяет название столбца 
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результата запроса. Таким образом, любому столбцу запроса можно назначить 

произвольное имя. 

17. В ячейке Поле четвертого столбца введите Дата последнего контакта: 

Дата. 

18. В первой строке пятого столбца бланка'запроса введите Число 

контактов: Дата. 

19. Снова щелкните на кнопке Вид. 

20. Закройте запрос. 

21. Для сохранения изменений структуры щелкните на кнопке Да. 

       22.  В окне диалога Сохранение (Save As) введите имя Итоговый запрос и 

щелкните на кнопке ОК. 

Запрос действия 

До сих пор вы сталкивались с запросами, выполняющими выборку данных 

и некоторые вычисления. Однако запросы могут применяться также для 

добавления, удаления и обновления группы записей таблицы. Такие запросы 

являются мощным инструментом преобразования данных, они называются 

запросами действия. Предположим, что по каким-то причинам вам понадобилось 

скорректировать даты контактов, заменив во всех записях таблицы Список, 

относящихся к 1999 году, месяц ноябрь на декабрь. Подобную операцию трудно 

проделать вручную,- если в таблице содержится несколько тысяч записей. Запрос 

действия позволяет быстро решить поставленную задачу.  

1. В окне базы данных щелкните на кнопке Таблицы. 

2. Выделите таблицу Список, данные которой нужно обновить. 

3. В палитре кнопки Новый объект (New Object) выберите пункт Запрос 

(Query). Откроется окно диалога Новый запрос (New Query), показанное на рис. 

6.3. Подобное окно открывается и при щелчке на кнопке Создать (New) окна базы 

данных. Оно позволяет выбрать наиболее удобный способ создания объекта. 

4. Дважды щелкните на строке Конструктор (Design View). Таблица 

Список, выделенная в окне базы данных на шаге 2, автоматически появится в 

окне конструктора запросов. 

5. Перетащите в бланк запроса поле Дата, значение которого нужно 

обновлять. 
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Рис. 6.3. Создание запроса 

6.  В палитре кнопки Тип запроса (Query Type) выберите пункт 

Обновление (Update Query). Описание всех возможных вариантов запросов, 

предлагаемых программой Access, приведено в табл. 6.2. Структура бланка 

запроса видоизменяется в соответствии с типом запроса. В бланке выбранного 

варианта запроса на обновление появляется поле Обновление (Update To), в 

которое нужно ввести новое значение поля. Чтобы изменить месяц даты с ноября 

на декабрь, достаточно прибавить к дате 30 дней. 

7. Введите в ячейку Обновление (Update To) формулу [Дата] +30 

8. Чтобы обновлялись только даты, относящиеся к ноябрю 2000 года, 

введите в ячейку Условие отбора формулу Between DateValue ("1.11.99") And 

DateValue ("30.11.99"). 

  9. Закройте запрос, сохранив его под именем Обновление.  

10. Щелкните на кнопке Таблицы окна базы данных и двойным щелчком 

на значке Список откройте эту таблицу. В ней есть четыре записи, относящиеся к 

ноябрю 2000 года.  

11.  В окне базы данных щелкните на кнопке Запросы. 
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Таблиця 6.2. Варианты запросов 

Тип Описание 

Выборка (Select); 
Выборка данных в таблицу результата запроса  

на основе указанных условий отбора  

Перекрестный 

(Crosstab) 

Результат запроса выводит статистические  

значения (сумму, количество или среднее) для  

одного из полей таблицы в зависимости от двух  

параметров других полей таблицы, задающих  

заголовки строк и столбцов результата  

перекрестного запроса  

Создание таблицы 

(Make-Table) 

Создание новой таблицы в текущей или в другой  

базе данных на базе информации из имеющихся  

таблиц  

Обновление (Update) Обновление данных таблицы  

Добавление  

(Append) 

Добавление набора записей в таблицу  

 

Удаление  (Delete) 
Удаление записей таблицы в соответствии  

с указанным критерием 

12. Дважды щелкните на значке Обновление. 

Ответьте Да на вопрос о необходимости запуска запроса действия. Access 

проинформирует вас об обнаружении четырех записей, удовлетворяющих 

условию отбора, и попросит подтвердить необходимость их изменения. 

 

Рис. 6.4. Запрос на обновление 

13. Щелкните на кнопке Да и изучите изменения, произошедшие с 

данными таблицы Список 

Вопросы для самопроверки 

1. Использование итогового запроса. 

2. Использование запроса действия. 

3. Варианты запросов. 
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ЛАБОРАТОРНАЯ РАБОТА 7 

ФИЛЬТРЫ 

Установка фильтра — простейший способ отбора части записей в таблице, 

запросе или форме. В этом упражнении с помощью фильтра будет выделено 

несколько записей таблицы Контакты. 

1. В окне базы данных щелкните на кнопке Таблицы, а затем дважды на 

значке Контакты. 

2. В столбце Фамилия щелкните на ячейке с фамилией Петров. 

3. Щелкните на кнопке Фильтр по выделенному (Filter By Selection). В 

результате видимыми останутся только те записи, в поле Фамилия которых 

присутствует значение Петров (рис. 7.1). 

4. Чтобы отменить влияние фильтра, щелкните на кнопке Удалить фильтр 

(Remove Filter).  

 

 

Рис. 7.1. Фильтрация записей 

 

Фильтр может быть и более сложным. Например, чтобы оставить все 

записи с фамилией Петров и непустым полем телефона, выполните следующие 

шаги.   

5. Выберите команду Записи > Фильтр > Расширенный фильтр (Records > 

Filter > Advanced Filter/Sort). Откроется окно, похожее на конструктор запроса. 

Критерий равенства поля Фамилия значению Петров уже будет присутствовать в 

бланке фильтра. 

6. Перетащите поле Рабочий Телефон во второй столбец бланка. 

7. В ячейку Условие отбора введите формулу <>Null (рис. 7.2). 

Значение любого пустого поля равно величине NuIL Условие < >NuII 

проверяет поле на неравенство величине Null, то есть отбирает все непустые поля. 
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8. Выберите команду Фильтр > Применить фильтр (Filter > Apply 

Filter/Sort). Настроенный" фильтр будет применен к таблице Контакты. В 

результате в ней останутся только две записи. 

9. С помощью команды Записи > Удалить фильтр (Records > Remove 

Filter/Sort) отмените фильтрацию. 

 

Рис. 7.2. Окно расширенного фильтра  

 

Вопросы для самопроверки 

1. Установка фильтру. 

2. Розширений фільтр. 

  3. Условие отбора не пустых полей таблицы 

             4. Отмена фильтра. 
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ЛАБОРАТОРНАЯ РАБОТА 8 

СОЗДАНИЕ ФОРМ С ПОМОЩЬЮ МАСТЕРА И КОНСТРУКТОРА 

ФОРМ. 

В то время как таблицы и запросы позволяют отобразить на экране 

длинные списки записей, формы дают возможность сосредоточиться на 

конкретной записи. Они облегчают ввод, редактирование и восприятие 

информации, могут содержать вспомогательные подписи и элементы 

оформления. 

Мастер форм 

Мастер форм позволяет сберечь время и быстро сконструировать 

привлекательную форму для записей любой таблицы. 

1. С помощью команды Файл > Открыть (File > Open) откройте базу 

данных Контакты, созданную на предыдущем занятии. 

2. В окне базы данных щелкните на кнопке Формы (Forms). 

3. В списке форм дважды щелкните на значке Создание формы с помощью 

мастера (Create Form By Using Wizard).  

4. В списке Таблицы/запросы первого окна мастера, показанного на рис. 

8.1, выберите пункт Таблица: Контакты. 

 

Рис. 8.1. Мастер форм 
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5. Щелкните на кнопке », чтобы добавить в список Выбранные поля все 

поля таблицы. 

6. Выделите пункт Код_Контакты и щелчком на кнопке <уберите это поле 

обратно в левый список. Содержимое поля Код_Контакты генерируется 

автоматически, а его значение несущественно для пользователя, поэтому не 

следует включать это поле в форму. 

7.  Щелкните на кнопке Далее. 

8. В следующем окне диалога выберите для формы стиль Выровненный 

(Justified) и щелкните на кнопке Далее. 

9. В списке третьего окна выберите вариант оформления Камень (Stone) 

или любой другой понравившийся вам стиль и снова щелкните на кнопке Далее. 

10. В последнем окне мастера щелкните на кнопке Готово, не изменяя 

никаких параметров. Мастер сгенерирует форму и откроет ее в режиме просмотра 

данных. 

11. Щелкните несколько раз на кнопке Следующая запись, чтобы 

добраться до информации о Василии Петрове. В этой записи отсутствуют адрес, 

название фирмы и телефон. 

12. Щелкните на поле ниже подписи Адрес и введите адрес Василия 

Петрова. 

13.  Аналогичным способом добавьте название компании и телефон 

(рис.8.2). 

 

Рис. 8.2. Форма для таблицы Контакты 
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14. Щелкните на кнопке Новая запись (New Record) и добавьте 

информацию еще об одном человеке. Как видите, форма позволяет просматривать 

и редактировать любую запись, а также добавлять записи. 

Конструктор форм 

Недостатком форм, создаваемых мастером, является то, что они 

однообразны и не содержат пояснительных надписей. Чтобы приукрасить форму 

и расположить поля более удобным образом, следует воспользоваться 

конструктором форм, который позволяет передвигать и масштабировать 

элементы формы, связывать их с источником данных и настраивать любые другие 

параметры формы. Давайте создадим с помощью конструктора форму для 

таблицы Список. 

1.  В окне базы данных дважды щелкните на значке Создать форму в 

режиме конструктора (Create Form In Design View). В окне конструктора 

присутствуют пустая форма с разметочной сеткой, вертикальная и горизонтальная 

линейки, помогающие позиционировать объекты (рис. 18.3). Неотъемлемым 

атрибутом конструктора форм является пацель инструментов Панель элементов 

(Toolbox), помогающая добавлять элементы формы. Новую форму необходимо 

связать с источником данных — таблицей Список. 

 

Рис. 8.3. Конструктор форм 
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2. Щелкните в пустой области конструктора и выберите в контекстном  

меню команду Свойства (Properties).  

3. На вкладке Данные (Data) окна диалога свойств формы (рис. 8.4) 

щелкните на стрелке поля Источник записей (Record Source).  

 

Рис. 8.4. Окно свойств формы 

4. Выберите в раскрывшемся списке пункт Список. 

5. Закройте окно свойств. В конструкторе форм появится небольшое окно 

со списком полей источника записей (таблицы Список). Это окно помогает 

добавлять элементы управления формы. Его можно скрывать или выводить на 

экран с помощью кнопки Список полей (Field List). Сейчас нужно добавить в 

форму три области ввода для трех полей таблицы. 

6. Поместите указатель на пункт Дата окна Список, нажмите кнопку мыши 

и перетащите этот пункт в область формы. Access создаст элемент управления 

типа поле, а также подпись. 

7. Проделайте аналогичную операцию для пунктов Описание и 

Код_Контакты, расположив поля примерно так, как показано на рис. 8.5. Любой 

объект формы можно выделить щелчком мыши, при этом вокруг него появляется 

габаритная рамка с боковыми и угловыми маркерами масштабирования объекта. 

В левом верхнем углу объекта появляется большой квадрат, за который можно 

перетаскивать объект в пределах формы. 
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Рис. 8.5. Добавление полей 

8. Щелчком выделите подпись Описание. Затем еще раз щелкните на ней, 

чтобы перейти в режим редактирования. Замените имеющийся текст на Описание 

контакта. 

9. Захватите правый боковой маркер поля Описание мышью и растяните 

рамку поля до правого края формы.  

10.  При необходимости, ухватившись за маркер перемещения мышью, 

подвигайте поле Описание. 

11. Повторите процедуры шагов 8-10 для всех трех полей. Разместите их и 

настройте подписи в соответствии с рис. 8.6. 

12. Чтобы привести оформление новой формы в соответствие с форматом 

формы, созданной в предыдущем упражнении, щелкните на кнопке Автоформат 

(AutoFormat) панели инструментов. 

13.  Выберите в списке открывшегося окна диалога пункт Камень и 

щелкните на кнопке ОК. Access приведет фон формы, оформление, цвет и шрифт 

полей в соответствие с выбранным шаблоном. 

14. Щелчком на кнопке Вид перейдите в режим редактирования данных. 

В форму будет выведено содержимое первой записи таблицы Список. 

Обратите внимание, что поле с подписью Фамилия имеет такой же список 
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подстановки, который был настроен для поля Код_Контакты таблицы Список на 

предыдущем занятии. Структура списка подстановки была перенесена в форму в 

процессе перетаскивания поля на шаге 7. 

 

Рис. 8.6. Готовая форма 

15. Закройте окно формы. 

16. В появившемся окне диалога введите в качестве имени новой формы 

слово С п и с о к и щелкните на кнопке О К. 

Теперь форма Список появится на вкладке Формы (Forms) окна базы 

данных.  

Элементы управления 

При открытии конструктора форм на экране появляется панель элементов 

(см. рис. 8.3). Если ее нет, щелкните на кнопке Панель элементов панели 

инструментов. С помощью кнопок панели элементов в форму можно добавлять 

различные объекты, типы которых перечислены в табл. 18.1. Элементы 

управления форм и отчетов сходны между собой, поэтому такая же панель 

элементов имеется и в конструкторе отчетов, о котором мы поговорим на этом 
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занятии позже, а все операции, рассматриваемые в этом и в следующем 

упражнении, одинаково применимы как к формам, так и к отчетам.  

 

Таблиця 8.1. Елементи управління форм і звітів 

Зна-

чок 
Назва Назначение 

1 2 3 

 
Надпись 

(Label)  

Надписи создаются автоматически вместе с элементами 

типа текстовое поле, поле со списком и т. п. Они 

разъясняют смысл поля ввода. Дополнительные надписи 

могут использоваться для заголовков и пояснений 

 
Поле 

(Text Box) 

Используется для ввода и отображения информации 

полей таблиц и запросов, а также для вывода результатов 

вычислений  

 

Группа 

переключателе

й 

(Option Group)  

Группа переключателей ссылается на некоторое поле 

таблицы. Каждый переключатель группы соответствует 

определенному целочисленному значению этого поля  

 
Выключатель 

(Toggle Button) 

Позволяет вводить информацию типа да/нет. Величине 

«да» или «истина» соответствует утопленное положение 

выключателя  

 

Переключатель 

(Option Button) 

Элемент группы переключателей, в которой может быть 

отмечен только один из них (его кружок выглядит 

зачерненным)  

 
Флажок (Check 

Box) 

Предназначен для представления полей типа да/нет. 

Отмеченный квадратик соответствует величине «да», а 

пустой — «нет»  

 

Поле со 

списком 

(Combo Box)  

Разрешает как непосредственный ввод значения в поле, 

так и его выбор в раскрывающемся списке 

предопределенных значений  

 
Список 

(List Box) 

Позволяет выбирать данные из набора пунктов и не 

разрешает непосредственный ввод значений 

 

Кнопка 

(Command 

Button) 

Щелчок на такой кнопке выполняет команду, с помощью 

которой можно перейти в другую форму, переместиться 

по записям и выполнить многие другие операции  

 



50 

 Рисунок Рисунок любого графического формата с рамкой  

 

Свободная 

рамка объекта 

(Unbound 

Object Frame) 

Объект OLE, связанный с полем данных таблицы или 

запроса  

 

Присоединенна

я рамка объекта 

(Bound Object 

Frame) 

Объект OLE, не связанный ни с каким источником 

данных  

 

Разрыв 

страницы (Page 

Break) 

Линия, по которой формируется перевод страницы при 

выводе формы или отчета на принтер  

 
Набор вкладок 

(Tab Control)  

Позволяет разместить на одном и том же пространстве 

экрана несколько наборов элементов управления. Удобен 

в тех случаях, когда элементы легко разделяются на 

логические группы  

 

Подчиненная 

форма/отчет 

(Subform / 

Subreport) 

Вставляет в форму (или отчет) область с другой формой 

(или отчетом), связанной с главной  

 Линия (Line) Добавляет прямую линию 

 
Прямоугольник 

(Rectangle) 

Рисует прозрачный или непрозрачный прямоугольник с 

цветной границей любой толщины  

 

Другие 

элементы 

(More Controls) 

Открывает меню с элементами управления, не 

вошедшими в панель элементов  

Чтобы с помощью панели элементов добавить в форму декоративные 

объекты, выполните следующие шаги.  

1. Поместите указатель мыши на угол области формы. 

2. Перетащите этот угол вправо вниз, чтобы немного увеличить форму. 

3. С помощью команды Правка > Выделить все (Edit > Select All) выделите 

все элементы формы. 

4. Нажмите клавишу Ctrl и, не отпуская ее, нажатиями клавиш со 

стрелками передвиньте элементы формы так, чтобы они были отцентрированы 

относительно новых границ формы. 
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5. Щелкните на кнопке Прямоугольник (Rectangle) панели элементов. 

6 Растяните мышью диагональ прямоугольника, чтобы он окружил все 

элементы формы (рис. 8.7). 

 

Рис. 8.7. Добавление элементов формы 

7. В палитре кнопки Цвет линии/границы (Line/Border Color) панели 

инструментов Форматирование (Formatting) выберите синий цвет.  

8. В палитре кнопки Толщина линии/границы (Line/Border Width) 

выберите толщину 4 пиксела. 

  9. Щелкните на кнопке Рисунок (Image) панели элементов.  

10. В левом нижнем углу формы растяните рамку рисунка. 

11.  В открывшемся окне выбора файла найдите папку, в которую был 

установлен Office XP (обычно она называется Microsoft Office), раскройте 

вложенную в нее папку Office10\Broadcast, выберите файл NS_logo.gif и 

щелкните на кнопке ОК. (Вместо этого файла можете вставить любой 

другой не слишком большой рисунок.)  
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Рис. 8.8. Параметры рисунка 

По умолчанию рисунки вставляются в форму в режиме урезания рисунка 

рамкой элемента. Чтобы изменить режим размещения, выполните следующие 

действия.  

12. Щелкните на рисунке правой кнопкой мыши и выберите в контекстном 

меню команду Свойства. 

13. В списке Установка размеров (Size Mode) вкладки Макет открывшегося 

окна параметров выберите пункт Вписать в рамку (Stretch), как показано на рис. 

18.8. Теперь рисунок будет растягиваться и сжиматься вместе с рамкой элемента, 

подстраиваясь под ее размеры. 

14. Закройте окно параметров. 

 

Вопросы для самопроверки 

1. Создание форм с помощью мастера форм. 

 2. Создание форм с помощью конструктора форм.  

3. Элементы управления форм.  

4. Параметры рисунка. 
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ЛАБОРАТОРНАЯ РАБОТА 9 

СОЗДАНИЕ ОТЧЕТА С ПОМОЩЬЮ МАСТЕРА И 

КОНСТРУКТОРА ОТЧЕТОВ. ГРУППИРОВКА И СОРТИРОВКА В 

ОТЧЕТАХ 

Мастер отчетов 

В целом отчеты похожи на формы, но они, как правило, предназначаются 

для вывода информации из базы данных на принтер. Поэтому в отчетах данные 

форматируют так, чтобы их было удобно размещать на отдельных страницах. 

Отчеты поддерживают самые разнообразные способы оформления и позволяют 

группировать данные, разбивая их на логически цельные блоки.  

Чтобы облегчить работу пользователя, в Access имеется специальный 

мастер, который при недостатке времени позволяет быстро создавать довольно 

привлекательные отчеты. Давайте поручим мастеру построение отчета о 

контактах с разными людьми. 

1. В окне базы данных щелкните на кнопке Отчеты (Reports).  

2. Дважды щелкните на значке Создание отчета с помощью мастера (Create 

Report By Using Wizard).  

В отчет нужно добавить как информацию о людях, так и данные о 

контактах с ними. Для этого следует сгруппировать вместе все контакты с одним 

человеком и распечатать их список ниже области с данными об этом человеке. 

Затем нужно вывести информацию о следующем человеке и список контактов с 

ним и т. д. Такой порядок печати записей позволит быстро найти полный список 

контактов с любым из ваших коллег. В первом окне мастера, показанном на рис. 

9.1, нужно указать все поля, включаемые в отчет.  

3. В раскрывающемся списке Таблицы и запросы первого окна мастера 

отчета выберите таблицу Контакты.  

4. В списке Доступные поля выделите поле Фамилия. 

5. Щелчком на кнопке > переместите выбранное поле в список Выбранные 

поля. 

3. 6. Повторяя шаги 4 и 5, добавьте в список Выбранные поля поля Имя, Адрес, 

Название Компании, Рабочий Телефон.  
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7. Выберите в списке Таблицы и запросы таблицу Список. 

 

Рис. 9.1. Выбор полей для отчета 

8. Переместите в список Выбранные поля Дата и Описание, добавив их к 

по лям таблицы Контакты. 

9. Щелкните на кнопке Далее. 

Во втором окне мастера можно выбрать способ расположения данных — 

упорядоченные по записям таблицы Контакты, а затем уже по записям таблицы 

Список, или наоборот. Схема группировки отображается в правой части окна 

диалога. 

10. Оставьте вариант Контакты (Контакты) и щелкните на кнопке Далее. 

11. В следующем окне не назначайте дополнительной группировки. 

Просто щелкните на кнопке Далее. 
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12. Четвертое окно мастера отчета позволяет задать порядок сортировки 

записей. Выберите в списке 1 пункт Дата и щелкните на кнопке Далее. 

Следующее окно, показанное на рис. 9.2., позволяет выбрать способ 

расположения полей и ориентацию страницы.  

 

 

Рис. 9.2. Пятое окно мастера отчетов 

13. Выберите положение переключателя Структура 1 (Outline 1). 

14. Затем щелкните на кнопке Далее. 

       15.  В следующем окне мастера выберите вариант оформления Строгий 

(Corporate) и щелкните на кнопке Далее.  

16. Введите в качестве заголовка текст Список контактов и щелкните на 

кнопке Готово. 
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Мастер сформирует отчет и откроет его в отдельном окне в режиме 

предварительного просмотра (рис. 9.3.). В нем видно, что сначала идет фамилия 

первого человека, информация о нем и список контактов с ним, затем 

располагаются те же данные, касающиеся второго человека, и т. д. В целом отчет 

выглядит неплохо и может устроить нетребовательного пользователя. 

 

Рис. 9.3. Фрагмент отчета, сгенерированного мастером 

Конструктор отчетов 

Если внимательно присмотреться к отчету, показанному на рис. 9.3, можно 

заметить несколько недостатков. Вот их список: 

•  названия таких полей, как Фамилия и Имя, явно лишние, их следует 

убрать; 
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• информация о человеке занимает слишком много места, ее можно 

представить компактнее; 

• некоторые подписи следует заменить более понятными; 

• поле Дата слишком коротко, оно не вмещает дату в длинном формате. 

Давайте исправим указанные недочеты в конструкторе отчетов.  

1. Чтобы переключиться в режим конструктора, выберите команду Вид > 

Конструктор. 

В схеме отчета (рис. 9.4) присутствует несколько разделов. Их назначение 

указано в табл. 9.1. Поля и подписи можно размещать в любом разделе отчета, 

регулируя этим их положение на странице. 

2. Щелчком выделите надпись Фамилия. 

3. Нажатием клавиши Delete удалите надпись.  
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Рис. 9.4. Конструктор отчетов 

Таблиця 9.1. Разделы отчета 

Раздел Назначение 

Заголовок отчета 

(Report Header) 

Печатается в самом начале отчета один раз. Выводится и 

скрывается командой Вид > Заголовок/примечание отчета 

(View > Report Header/Footer)  

Верхний 

колонтитул (Page 

Header) 

Печатается в верхнем поле каждой страницы. Выводится и 

скрывается командой Вид > Колонтитулы (View > Page 

Header/Footer)  

Заголовок группы 

КолКонтакты 

(КонтактиЮ 

Header)  

Появляется в начале каждой группы записей, 

соответствующих очередному значению поля КодКонтакты 

(то есть того поля, по которому назначена группировка)  

Область данных 

(Detail) 
Основные данные отчета 

Нижний 

колонтитул (Page 

Footer) 

Печатается в нижнем поле каждой страницы. Выводится и 

скрывается командой Вид > Колонтитулы (View > Page 

Header/Footer) 

Примечание отчета 

(Report Footer) 

Печатается в самом конце отчета. Выводится и скрывается 

командой Вид > Заголовок/примечание отчета (View > 

Report Header/Footer) 

4.  Повторяя шаги 2 и 3, удалите из раздела Заголовок группы 

Код_Контакты надписи Имя, Дата и Описание. Назначение соответствующих 

полей очевидно и не нуждается в пояснении. 

5. Щелкните на горизонтальной линии, расположенной ниже поля 

Назвакие Компании, правой кнопкой мыши и выберите команду Вырезать (Cut). 

6. Аналогичным приемом удалите три оставшиеся линии раздела 

Заголовок группы Код_Контакты. Нет смысла выводить подписи полей адреса, 

названия компании и телефона в заголовке каждой группы. Достаточно будет 

поместить соответствующие надписи в верхний колонтитул страницы. 

7.  Поместите указатель мыши между заголовками разделов Верхний 

колонтитул и Заголовок группы Код_Контакты, чтобы его значок превратился в 

двунаправленную стрелку. Нажмите кнопку мыши и перетащите заголовок 

группы вниз, освобождая место для верхнего колонтитула. 
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8. Щелчком выделите надпись Адрес. Нажмите клавиши Ctrl+X, чтобы 

вырезать ее. 

9. Щелкните на заголовке раздела Верхний колонтитул и нажмите клавиши 

Ctrl+V, чтобы вставить вырезанную надпись в верхний колонтитул. 

10. Выделяя надписи колонтитула и перетаскивая их мышью за маркер 

верхнего левого угла либо передвигая нажатием клавиши Ctrl и клавиш со 

стрелками, разместите их так, как показано на рис. 9.5. 

 

Рис. 9.5. Перемещение надписей между разделами 

11.  Щелкните на надписи Адрес. Повторным щелчком на ней включите 

режим редактирования и замените текст на Почтовый адрес. 

12. Описанным выше приемом измените текст подписей Название 

Компании и Рабочий Телефон соответственно на Компания и Телефон. 
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13. Переставьте поля раздела Заголовок группы Код_Контакты, разместив 

их в две строки. Фамилия и имя — в первой строке, а остальные три поля — во 

второй. 

14. Щелкните правой кнопкой мыши на жирной линии, расположенной в 

разделе Заголовок отчета. Выберите в контекстном меню команду Копировать 

(Copy). 

15. Щелкните на заголовке раздела Заголовок группы Код_Контакты и 

нажмите клавиши Ctrl+V, чтобы вставить в этот раздел дубликат линии. 

16. Нажимая клавиши Ctrl+V, переместите линию вниз, под вторую строку 

полей данных. 

17. Снова нажмите Ctrl+V, добавив вторую линию вдоль верхнего края 

раздела. 

18.  Перетащите заголовок раздела Область данных вверх, убрав излишнее 

пустое пространство. 

19. Щелчком выделите поле Дата. Увеличьте его горизонтальный размер, 

перетащив вправо серединный маркер правой границы поля. 

20. Растяните поле Описание вправо до границы отчета. Окончательный 

вид новой структуры отчета показан на рис. 9.6. 

 

Рис. 9.6. Модифицированная структура отчета 
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21. С помощью команды Вид > Предварительный просмотр (View > Print 

Preview) переключите отчет в режим вывода данных. В новом варианте, 

показанном на рис.9.7., информация размещается намного компактнее. 

 

Рис. 9.7.Просмотр нового варианта отчета 

22. Закройте отчет. При появлении запроса о необходимости сохранения 

новой структуры отчета щелкните на кнопке Да. 

Группировка и сортировка 

Отчет, который вы сконструировали в двух предыдущих упражнениях, 

имеет еще один существенный недостаток. Фамилии людей из списка Контакты 

выводятся не по алфавиту. Мастер отчетов автоматически сгруппировал данные 

таблицы Список по их принадлежности к тем или иным записям таблицы 

Контакты, которая определяется связью между полями Код_Контакты этих двух 

таблиц. По указанной причине фамилии в отчете упорядочены по возрастанию 

числового параметра Код_Контакты — идентификатора записей таблицы 

Контакты. Это неудобно, в отчетах с большим числом записей при такой 
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сортировке будет довольно трудно отыскать нужного человека. Есть смысл 

изменить порядок сортировки, для этого выполните следующие шаги. 

1. Щелкните на кнопке Отчеты окна базы данных. 

2. Выделите значок отчета Список контактов. 

             3. Щелчком на кнопке Конструктор панели инструментов окна базы 

данных откройте отчет в режиме конструктора.  

4. Щелкните на кнопке Сортировка и группировка (Sorting And Grouping) 

панели инструментов, чтобы открыть окно диалога, показанное на рис. 9.8.  

 

Рис. 9.8. Сортировка и группировка 

В этом окне назначены два уровня сортировки. Сначала в порядке 

возрастания по полю Код_Контакты, а затем в пределах списка контактов, 

относящихся к одному человеку, по возрастанию даты контакта. На кнопке 

строки Код_Контакты виден значок, указывающий на то, что записи 

группируются по данному полю, то есть при перебаре записей таблицы Контакты 

для каждого нового значения поля Код_Контакты генерируется заголовок группы, 

в котором, как вы должны помнить из предыдущего упражнения, выводятся имя, 

фамилия и другие характеристики людей. 

Казалось бы, можно просто изменить поле сортировки Код_Контакты на 

Фамилия, и записи в отчете сразу же выстроятся по алфавиту. Но в этом случае 

для четырех людей с одинаковой фамилией Петров будет выведен только один 

заголовок группы, ниже которого разместится список контактов со всеми 

Петровыми. Вспомните, что новый заголовок группы выводится только для 

каждого нового значения поля, по которому выполняется группировка. 

Код_Контакты — уникальный идентификатор записей таблицы Контакты, 

группировка по которому обеспечивает вывод в отчет всех записей этой таблицы. 

Для сортировки записей по алфавиту фамилий и имен следует добавить в список 
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окна диалога Сортировка и группировка (Sorting And Grouping) соответствующие 

поля, разместив их выше поля группировки Код_Контакты. 

5. Щелкните в третьей строке на кнопке раскрывающегося списка 

Поле/выражение (Field/Expression). 

6. Выберите пункт Фамилия. 

7. В раскрывающемся списке Поле/выражение четвертой строки окна 

Сортировка и группировка выберите пункт Имя. 

8. Щелчком на кнопке строки Фамилия выделите ее. 

9. Поместите указатель на кнопку строки Фамилия, нажмите кнопку мыши 

и перетащите строку на самый верх списка. Отпустите кнопку мыши в тот 

момент, когда жирная горизонтальная линия, показывающая будущее 

расположение перемещаемой строки, окажется над первой строкой таблицы. 

10. Повторяя шаги 8 и 9, разместите строку Имя между строками Фамилия 

и Код_Контакты, как показано на рис. 9.9.  

 

Рис. 9.9. Добавление полей сортировки  

11. Закройте окно Сортировка и группировка. 

12. Щелкните на кнопке Вид панели инструментов, чтобы вывести отчет в 

режиме предварительного просмотра. 

Теперь записи сначала сортируются по фамилиям, затем по именам. После 

этого для каждой новой записи таблицы Контакты появляется заголовок группы 

(так как величины поля Код_Контакты для всех записей различны). Ниже каждого 

такого заголовка из таблицы Список выводятся все контакты, соответствующие 
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данному значению величины Код_Контакты, то есть данному человеку (рис. 

9.10). 

 

Рис. 9.10. Окончательный вид отчета  

13. Закройте отчет. 

 

Вопросы для самопроверки 

1. Создание отчета с помощью мастера отчетов.  

2. Создание отчета с помощью конструктора отчетов.  

3. Группировка данных.  

4. Сортировка данных.
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